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If you’re a Dentrix Essentials customer, it’s
time to step up your game. Right now you can
claim deep discounts when you upgrade your
service bundle to Momentum or Optimum.
Both bundles include eClaims so you can submit and
track insurance claims electronically, directly from Dentrix.
Upgrade now to add:
• eClaims for as little as 40 cents each
• Unlimited digital claim attachments
• Integrated billing and collectio n tools
• Automated appointment reminders
• Up to 20% transaction discount on eClaims, reminder
postcards and QuickBill statements

Call 1-800-734-5561, option 2 to determine
the best bundle for your practice.

You deserve more.
Dentrix.com/ServiceBundles
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Is Your Team Ready
for Your Success?
Add value to your Dentrix solution by
empowering the people who use it.
Dentrix Mastery Tracks will make sure every member of your
team is as prepared and capable as your technology—by giving
you a fast and affordable way to test what they know about
Dentrix and find out where they need improvement. It also
directs them to the targeted training they need to enhance
their skills and improve your practice.

To get started, visit Dentrix.com/Mastery

Dentrix Mastery Tracks

SPOTLIGHT
Dentrix Mastery Tracks™ allows dental professionals
to test how well they understand and can use Dentrix.
Read on to find out about Casey Wright, a practice
administrator who has completed eight Mastery Tracks
tests and earned all four specialist certificates.

CASEY WRIGHT | PRACTICE ADMINISTRATOR

Where do you work?
Borsky Dental Group and Eastern Hills Dental, Cincinnati, Ohio

Front Office Specialist, Dentrix Financial Specialist, Dentrix
Practice Analysis Specialist, and Dentrix Clinical Specialist.

What is your title?

What got you interested in Dentrix Mastery Tracks?

Practice Administrator

I am always in search of educational opportunities and
certifications. When I found out Dentrix was offering a program
that would test and expand my knowledge of a critical system
used for my practices, I couldn’t wait to try it out.

What are some of the duties you’re responsible for in
your practice?
I manage all of the daily activities of two offices consisting of
10 employees at one location and 5 at another. I am in charge
of all HR matters including recruiting and hiring team members,
as well as payroll administration and employee coaching and
training. I monitor practice reports and implement changes
in systems to meet the ever-changing needs of the practices,
and ensure they meet collection, production, and customer
service goals. I monitor accounts receivable and treatment
presentation reports to ensure policies are being followed and
goals are being met. I handle all responsibilities relating to
practice finances including accounts payable and setting up
and adhering to budgets to meet practice goals.

How long have you been with this practice?
I have been with the practice for 16 years. This included a
practice transition and purchasing two additional practices.

How long have you worked with Dentrix?
I have worked with Dentrix for approximately 20 years.

Which certificates have you earned?
I have earned all four of the Dentrix Specialist Certificates: Dentrix

How has participating in Mastery Tracks helped you
use Dentrix?
I have learned a lot through Mastery Tracks and have been able
to implement new daily procedures because of it. I have also
used Mastery Tracks as a tool to test the knowledge of potential
team members.

How has becoming a Dentrix specialist improved your
career?
Achieving any certificate gives me a great sense of pride.
Achieving certificates in such a critical system that is a
cornerstone of our practice gave me the confidence to
transition a newly purchased practice to Dentrix and provide
training to the team.

What is your favorite Dentrix tip or trick?
There are so many great things about Dentrix it is hard to pick
one. The two things that help me the most on a daily basis
are the Treatment Manager and the Practice Advisor. The List
Manager is also a really great feature that allows me to be able
to track many things easily.

Is your team ready for your success? Visit Dentrix.com/Mastery and start using Dentrix Mastery
Tracks to give your team the tools they need to measure and improve their Dentrix skills.
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Dentrix News

Announcing New Insurance Payor Connections

Attachments

eClaims

The following payors now accept electronic claim
attachments. With electronic attachments, you can add
digital X-rays, EOBs, photos and perio charts to the electronic
claims you send.

Dentrix has eClaims connections with several new payors.
For patients using the following insurance carriers, you can
reduce paper claims by submitting electronic claims through
Dentrix instead.

Payor ID
Payor Name
CX014		Advantage by Peach State Health Plan Medicare
(Doral/Dentaquest)
CX014		Aetna of Louisiana (Doral/Dentaquest)
CX014		Affinity Essentials Health Plan (Doral/Dentaquest)
CX014		AMERIGROUP Community Care- Medicare (Doral/
Dentaquest)
CX014		Amerigroup of Louisiana (Doral/Dentaquest)
CX014		Amerigroup of MD Community Care Medicaid
(Doral/Dentaquest)
CX014		Amerigroup Washington Medicare (Doral/
Dentaquest)
CX014		Anthem Colorado Medicare (Doral/Dentaquest)
CX014		AZ Mercy Care Advantage (Doral/Dentaquest)
CX014		AZ Mercy Care Plan Medicaid (Doral/Dentaquest)
CX014		AZ Phoenix Health Plan Medicaid (Doral/
Dentaquest)
CX014		AZ Phoenix Health Plans Medicare (Doral/
Dentaquest)
CX014		BCBS of Illinois Medicaid (Doral/Dentaquest)
CX014		BCI of Idaho (Doral/Dentaquest)
CX014		BCI SNP ID-Medicare (Doral/Dentaquest)
CX014		Blue Cross Community Centennial (Doral/
Dentaquest)
CX014		BMC Health Net Plan SCO- HMO SMP (Doral/
Dentaquest)
CX014		BMC Health Net Plan SCO Medicaid (Doral/
Dentaquest)
CX014		CA Molina Healthcare (Doral/Dentaquest)
CX014		Colorado Medicaid Waiver (Doral/Dentaquest)
CX014		Community Care Alliance of IL-Medicaid (Doral/
Dentaquest)
CX014		Community Care Alliance of IL-Medicare (Doral/
Dentaquest)
CX014		Community Charter School of Excellence (Doral/
Dentaquest)
IDIND		Delta Dental of Illinois Individual Plan
CX014		FL Amerigroup Medicaid (Doral/Dentaquest)

Payor ID
Payor Name
CX014		Advantage by Peach State Health Plan Medicare
(Doral/Dentaquest)
CX014		Aetna of Louisiana (Doral/Dentaquest)
CX014		Affinity Essentials Health Plan (Doral/Dentaquest)
CX014		AMERIGROUP Community Care- Medicare (Doral/
Dentaquest)
CX014		Amerigroup of Louisiana (Doral/Dentaquest)
CX014		Amerigroup of MD Community Care Medicaid
(Doral/Dentaquest)
CX014		Amerigroup Washington Medicare (Doral/Dentaquest)
CX014		Anthem Colorado Medicare (Doral/Dentaquest)
CX014		AZ Mercy Care Advantage (Doral/Dentaquest)
CX014		AZ Mercy Care Plan Medicaid (Doral/Dentaquest)
CX014		AZ Phoenix Health Plan Medicaid (Doral/
Dentaquest)
CX014		AZ Phoenix Health Plans Medicare (Doral/Dentaquest)
CX014		BCBS of Illinois Medicaid (Doral/Dentaquest)
CX014		BCI of Idaho (Doral/Dentaquest)
CX014		BCI SNP ID-Medicare (Doral/Dentaquest)
CX014		Blue Cross Community Centennial (Doral/
Dentaquest)
CX014		BMC Health Net Plan SCO- HMO SMP (Doral/
Dentaquest)
CX014		BMC Health Net Plan SCO Medicaid (Doral/
Dentaquest)
CX014		CA Molina Healthcare (Doral/Dentaquest)
CX014		Colorado Medicaid Waiver (Doral/Dentaquest)
CX014		Community Care Alliance of IL-Medicaid (Doral/
Dentaquest)
CX014		Community Care Alliance of IL-Medicare (Doral/
Dentaquest)
CX014		Community Charter School of Excellence (Doral/
Dentaquest)
CX014		FL Amerigroup Medicaid (Doral/Dentaquest)
31149		McGregor PACE

For more information about electronic insurance claim
attachments, visit www.dentrix.com/products/eservices/
eclaims/attachments.

22823		Mid America Benefits
For more information about Dentrix eClaims, visit www.dentrix.
com/products/eservices/eclaims.
View the entire list of electronic payor connections using the
Payor Search Tool at www.dentrix.com/products/eservices/
eclaims/payor-search. You can search for specific payors or
download the complete payor list.
Call 800-734-5561 for help setting up any of these services.
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2017 ADA-CDT Dental Codes Update
click Updates and then click Check for Updates. The CDT 2017
Update should appear as an optional update. Select the CDT
2017 Update and click Yes to install the update.
The 2017 ADA-CDT Dental Codes Update will soon be available
for Dentrix customers running Dentrix G5.2, G6, G6.1, and G6.2.
The update includes 11 new ADA-CDT procedure codes and
changes to some existing procedure codes.
Dental offices on a Customer Service Plan using Dentrix G5.2,
G6, G6.1, and G6.2 will have the update available through the
update manager. To find the Check for Updates tool, rightclick the Dentrix Quick Launch icon in the notification area of
the Windows taskbar to open the Quick Launch menu. Next,

If the Dentrix Quick Launch icon is not displayed in the
notification area of the Windows taskbar, you can check for
updates by clicking About Dentrix from the Help menu of any
Dentrix module and then clicking Check for Updates.
If you are not currently on a Customer Service Plan, please
contact our Sales department today to learn more about the
great benefits of being on a Dentrix Suite. They can be reached
by calling (800) 336-8749, option 1. You can also visit us at
www.dentrix.com/suites to learn more.

is here

To learn more or to upgrade, visit Dentrix.com/G6.
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Product
Management

What Dentrix Customers Can
Look Forward To
Dentrix Updates
We are excited about some of the features and updates we
have planned for upcoming releases. While we cannot give
specific dates to these updates, we are looking forward to
a new payment agreement manager in Dentrix. This will
give you a single point of access for all of your payment
agreements and allows you to record patient payments
from this module. If you use PowerPay, you will also be able
to associate consents with these payment agreements and
see a more seamless integration of PowerPay’s credit card
payment functionality into the Enter Payment and Insurance
Payment dialog boxes. This means that you will be able to
add credit card payments to insurance claims!

Learn what’s coming in 2017 and beyond.

I

n recent months, we have been working on the Dentrix
strategic plan for 2017 and beyond. It is exciting to meet
with customers and collect feedback on these plans. As an
example, we recently held our Solutions Summit where we
invited many key opinion leaders in the industry to discuss
their thoughts and provide feedback on Dentrix. The two days
of meetings provided me and others with an opportunity to
discuss trends and issues affecting dental practices today and
changes on the horizon. This feedback is invaluable as we
navigate the rapidly changing dental landscape.

These feature additions
and enhancements are
just a highlight of the
updates coming.
To thank you for your continued loyalty, provide a glimpse of
what’s coming, and hear your feedback, I want to give you a
sneak peak of what you can expect in the near future from
Dentrix and its eServices.
No Changes to Customer Service Fees
As has been the case for the last two years, the Dentrix
Essentials Customer Service Plan price will stay the same
in 2017. You can continue to enjoy the same benefits you
currently have with your support plan for the same great
price for another year!

Additionally there will be a significant update to the Month
End process. We are creating a Task Scheduler that will allow
you to schedule month end, late charges, finance charges,
and select reports to run automatically. So during Month
End, you can set it to run the first day of every month at
12:00 a.m. when no one is in the office. That way when you
arrive the next morning you are ready to start the day. More
importantly, if somebody left the Appointment Book open in
Dentrix, don’t worry, this will no longer be an issue!
Finally, we are working on a health history module and some
significant changes to the Questionnaires setup process.
As we know this is a very important part of the patient’s
electronic medical record and, based on feedback from you,
there are some amazing additions and updates coming.
These feature additions and enhancements are just a
highlight of the updates coming.
Dentrix eServices
Several enhancements are planned for our Dentrix eServices
also. In addition to improvements already outlined in the way
Dentrix integrates credit card processing, product updates
will also support new terminals with chip cards and that are
compatible with NFC contactless payments (such as Apple
Pay). Our attachment service will also be updated so that
you get your NEA number back immediately, improving the
experience when additional details are required by the payor.
Finally, we are excited to announce that our online booking
product will also be available.
As I stated previously, we greatly appreciate your loyalty! We
are confident that as we work together in 2017 and beyond,
we will continue to help you achieve your practice goals. If
you have any questions about these plans for next year or
would like to provide feedback, please don’t hesitate to reach
out to me at brad.royer@henryschein.com.

BRAD ROYER
Dentrix Product Manager
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Get Dentrix News,
Tips and Information
Sent Right to Your Inbox.
The Dentrix eNewsletter will help you stay up to date on the latest Dentrix
product information, education opportunities, industry news, tips and
tricks, promotional offers and more! Once a month you’ll receive an
eNewsletter featuring the following content:

Product
Information

Training
& Support

The Dental
Business

Partner
Products

Tips
& Tricks

Sign Up Today at www.Dentrix.com/newsletter
and don’t miss out on the most up-to-date Dentrix information!

©2015 Henry Schein, Inc. A-DTXENEW-Q315

Tips

&Tricks
The Dentrix Mastery Tracks™ program helps you
assess and improve your Dentrix skills. Find
tips that correspond with your job and use
them to prepare for a test or just enhance your
skills. Visit www.Dentrix.com/Mastery to learn
more about Dentrix Mastery Tracks.
Front Office

Financial

Practice Analysis

Clinical

Auto-opening the Select Patient Dialog Box
In Dentrix G6.1 a new feature was added which automatically opens
the Select Patient dialog box when a patient-specific module is
opened for first time and no active patient is currently selected. This
feature saves time because you don’t have to click File > Select
Patient every time a new module is opened. This feature assumes
that when you open a patient-specific module, your next step will be
to select a patient.
This option is turned on by default, but you can easily customize it for
each workstation to accommodate your personal preferences.
1. In the Office Manager, select Maintenance > Practice Setup >
Preferences.
2. In the General Options tab, under the Additional Options group
box, check or uncheck the box for Automatically Launch Select
Patient.
• If checked, the feature is active.
• If unchecked, the feature is inactive.
3. Click OK to save your changes and exit.
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Determining the Last Time a Patient
Received a Billing Statement
Did you know Dentrix keeps track of the
last time you billed a patient and lists
that information for you in the Ledger?
In the Ledger, the Last Statement Date field
reflects the last time the selected patient was
sent a billing statement. Each time you print a
billing statement for a patient or send a statement
electronically, the Last Statement Date field is
updated.
Note: The Last Statement Date field is NOT
updated if you generate a billing statement and
send it to the Batch Processor. The date is only
updated after you print the statement or send
it electronically. This is true both of statements
generated from the Office Manager and individual
statements generated from the Ledger.

Viewing Patient Notes in the Family File
A new feature, added in Dentrix G6.1, allows you
to automatically see patient notes in the Family
File. In previous Dentrix versions, patient notes
were hidden by default, and you would have to
open them for individuals on a patient-by-patient basis.
With this new feature, you can turn them on (or off)
for all patients as the default, depending on your office
preferences.
This option by default is turned on, meaning patient notes
will automatically be visible, but you can quickly customize
it for each workstation in your practice, depending on your
patient information protocol.

Dentrix G6 Appointment Book Enhancements
You May Have Missed
For those of you who have already upgraded to
Dentrix G6, here a just a few new features and
enhancements related to the Appointment Book
you may not be aware of:
•
•

To enable or disable the feature:
1. In the Office Manager, select Maintenance > Practice
Setup > Preferences.
2. In the General Options tab, under the Additional
Options group box, check or uncheck the box for
Auto View Patient Note in Family File.
• If checked, the feature is active.
Note: If you hide the patient notes in an individual
record, the notes will be visible again the next time
you open the Family File for that patient.
• If unchecked, the feature is inactive and you must
click the View button in the Family File to see the
patient’s notes.
3. Click OK to save your changes and exit.

•
•

When you archive a patient, that patient’s
appointments are removed from the Unscheduled List.
When you click the Tx button to select treatmentplanned procedures for the appointment reason, the
procedures listed there are now grouped by treatment
plan case.
Purged appointments now appear in the Audit
Trail Report.
Only one person can edit the Appointment Book Day
Note at a time. When someone is editing the note, the
note is now locked so that no one else can edit it at
the same time.

Using Dental Plan Maximums in the
Treatment Planner
The Treatment Planner provides insurance
estimates and patient portions for the patient.
These estimates are based on how the coverage
table and payment tables are set up in the Family File. You
have the option to have the Treatment Planner consider the
patient’s yearly maximum when viewing these estimates.
To prevent the Treatment Planner from calculating an
insurance estimate that is more than the patient’s annual
maximum, from the Treatment Planner, select Insurance >
Use Dental Plan Maximums and Deductibles.
If this option has a check mark next to it, the annual
maximums for this patient are reflected in the insurance
estimates and the patient’s portion.
Note: This is a global setting and once this option has
been checked, maximums are considered on all patients
until unchecked.
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Accessing Patient Information from the Select
Patient Dialog Box
You can use the Select Patient dialog
box for more than just selecting patients!
It’s a powerful search tool that lets you
search by lots of different criteria, and the
Appointments tab gives you a list of all the
patients scheduled for today.
But did you know that you can right-click a
patient’s name for even more options? When
you right-click a patient’s name, it opens a
menu where you can either open the More
Info dialog box for that patient, or you can
select the name of a family member and
open the module for that family member. This
feature is especially helpful when you have
two patients with the same name and you
need to see which is which.

Adding a Reminder to the Day Sheet to Follow Up
on Difficult Procedures
When a patient has a difficult procedure completed,
like a root canal or extraction, many offices make
follow-up calls to that patient in the evening after
their procedure. Dentrix helps you identify which
patients may need a follow-up call by adding an
asterisk on the Day Sheet next to the phone
number of any patient who had a difficult
procedure completed.
Dentrix considers a procedure to be “difficult” when
it has been flagged in the Procedure Code Editor
as a difficult procedure. You can customize which
procedures are considered difficult and show up on
the Day Sheet with an asterisk.
To flag a procedure as a Difficult Procedure:
1. From the Office Manager, click Maintenance >
Practice Setup > Procedure Code Setup.
2. Select the procedure you want to flag and
click Edit.
3. Check the Difficult Proc. option in the
Treatment Flags group box.
4. Click Save.
5. Click Close.
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We’re All Connecting
One Integrated Community

With digital technology making its way into every dental practice, Henry Schein continues to provide a wide choice of solutions
to help practioners navigate the rapidly changing world of digital dentistry. We are pleased to announce that our Digital
Impression Scanners are now integrated with Henry Schein Dentrix practice management software via DDX. No more separate
files—as a Dentrix Connected device, your intraoral scans will be embedded in the Dentrix patient chart, allowing staff to view
scans on any PC in the network at any time. Automate your workflows, strengthen lab collaboration, simplify image archival and
access to your digital documentation by adding a Digital Impression Scanner to your clinical workflow today.

Join the Community.

Ask your Henry Schein Consultant about Dentrix Connected
digital intraoral scanning solutions or call 1-844-223-9901 today.
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SCHEDULING TASK
REMINDERS IN THE
APPOINTMENT BOOK
Discover how to create custom task reminders and display them right in Dentrix.
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M

ost of us use to-do lists to remind us of important
tasks that need to get done. We scribble hand-written
sticky notes, use smartphone apps, send ourselves
email and text messages, and make lists on our PC.

Dentrix provides different tools to help with your daily task
reminders, such as Office Journal reminders and the Appointment
Book Day Note. We’ve seen dental offices using these methods
to help manage their daily tasks, and each one has its own
advantages and disadvantages. But there’s another method that
you may not have considered. Using Dentrix, you can schedule
individual task reminders for each provider and staff member
right in the Dentrix Appointment Book at the date and time the
tasks need to be done.
The secret is to create extra operatory columns in the Appointment
Book as “TODO” list columns, one for each member of your dental
team, and then schedule your task reminders as events in those
columns (Figure 1). Using custom views, each staff member can
have his or her individual task list appear right next to the patient
schedule so it’s always visible when the Appointment Book is
open. This article explains how to set this up in Dentrix and then
offers a few tips and suggestions for using the Appointment Book
to help manage your daily tasks.

Figure 1 Use the Appointment Book to help manage your daily
task reminders.
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Creating Additional Operatory Columns
To begin, in the Office Manager, from the Maintenance menu, point
to Practice Setup, and then click Practice Resource Setup. Under
Operatories, click New. In the ID field, type a four-character name
for your task list. If you’re creating only a single task list for yourself,
you could type “TODO” or “TASK”. If you want to create task lists
for multiple staff members, you may want to use employee initials
or an abbreviated name.
Keep in mind that the Appointment Book displays the operatories
alphabetically by ID. So if you want task lists to always appear on
the right side of the Appointment Book, you may want to use an
underscore character ( _ ) at the beginning of the name, followed
by three letters, such as _KEL. (The Operatory Title is an optional
field and isn’t needed, but you could type the person’s full name
there if you want.) When finished, click OK. Repeat these steps
if you want to create columns for other staff members. When
finished, click Close.
If the Appointment Book is already open, from the File menu click
Refresh. If the Appointment Book isn’t already open, open it.

Figure 2 Use the
Select View dialog
box to create a
new Appointment
Book view.

From the menu bar in the Appointment Book, click View, and
then click New. Under Operatories, select the operatories you
want to include in your view, including the new task list you
created (such as “TODO”). Set any other view options you
want and click OK when finished. In the Select View dialog box
(Figure 2), make a mental note of the view number you just created
(such as 02 – F2). Later, you can press that function key on your
keyboard (such as F2) to quickly display that view with your task
list. You can then press the function key for your original view (such
as F1) to hide your task list and display the original Appointment
Book view.
Click OK. Your new task list should appear on the right side of the
Appointment Book. If it doesn’t, press the function key for that
view, such as F2.
Next, close the operatory you just created so it isn’t counted as
open time in the schedule. To close the operatory, right-click the
heading for the operatory (such as TODO), and click Operatory
Setup. Make sure the correct operatory name is selected in the list,
and then click Setup. Under Default Schedule, clear all check boxes.
Click OK, and then click Close. The background color changes to
show that the operatory is closed.
If other views are defined, you can press those function keys
(such as F1) to practice changing the view. When you’re ready to
schedule tasks, press the function key to change back to your new
task view.
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Scheduling Tasks
Now that your task list column is created and the Appointment
Book view is selected, you are ready to create task reminders
by scheduling events in your TODO operatory at the times you
want the task to be completed. Right-click in your task column
in the Appointment Book where you want to create a task
reminder, and from the shortcut menu, click Schedule Event.
The Schedule Event dialog box appears (Figure 3). Under
Description, type the task reminder, such as “Call patient Brent
Crosby: 801-555-1111.” You can type a maximum of 60 characters
in this field. If you need to type more detail, you can use the
Notes field. (Any text you type in the Notes field will later
appear in the Appointment Book Hover window when you rest
your mouse pointer over the task.)
For recurring task reminders or events (such as a daily huddle
meeting each morning), under Event Days, specify the Start and
End dates for the event. Next, select the days of the week when
you want the task or event to occur. If you want to post the
task reminder or event to the task calendar of other employees,
select those task lists under Operatories. You can schedule
recurring events in the Dentrix Appointment Book up to one
year. However, because Dentrix doesn’t let you edit an event
series, if you anticipate that you may need to edit or update the
event/task later, you may want to schedule only a few recurring
instances at a time. (You can always extend those recurring
tasks later as you go along.) When finished, click OK, and the
task appears at the scheduled time in the Appointment Book.

Using Dentrix, you can
schedule individual
task reminders for
each provider and staff
member right in the
Dentrix Appointment
Book at the date and
time the tasks need
to be done. The secret
is to create extra
operatory columns in the
Appointment Book as
“TODO” list columns.

Figure 3 Use the Schedule Event
dialog box to create new task
reminders.
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Tips and Suggestions
Here are a few ideas to help you manage your tasks in the Appointment Book:
•

To help prevent appointments from being accidentally scheduled in your task-list operatory
columns, you should set these fake operatories to closed. With the operatory closed, if anyone
tries to schedule an appointment in this column, the message, “The Operatory is not open at
the requested time!” appears as a reminder not to schedule appointments here. However, this
message does not appear when scheduling events.

•

For tasks with notes, rest your mouse pointer over the task to display the notes in the Hover
window. Because the Hover window displays only five lines of an event note, when you create
your tasks you may want to separate list items with a comma or use spaces to display them in
columns (Figure 4).

Figure 4 Use the Hover window to view details about each task reminder.
•

When tasks are completed, you can either right-click the task and click Delete Event, or doubleclick the task and add “ - done” at the end of the Description. Adding “ - done” allows the task
to remain on the schedule as a permanent record of when the task was completed, in case you
need to refer back to it later.

•

You may want to define a color code for your tasks and use the Event Color button in the
Schedule/Edit Event dialog box to assign colors to certain tasks. For example, you could use
red for urgent or overdue tasks, and use white for tasks with normal priority. Or you could use
different colors to represent different types of recurring tasks, such as white for one-time tasks,
yellow for daily tasks, green for weekly tasks, and blue for monthly tasks.

•

If you don’t get the task done on the day it’s scheduled, you can reschedule it by moving it to the
Pinboard, by double-clicking, or by dragging it to a new date using the Week view.

•

If a task needs to be assigned to someone else, you can easily move it to someone else’s task list.
To do this, double-click the task, select that person’s task list under Operatories, and then click
OK. You can also do this by displaying an Appointment Book view that includes both task lists
and then drag the task from your list to the new task list.

•

For tasks that may take several days to complete or have the potential of being postponed, you
can use Insert Dateline in the Schedule/Edit Event dialog box to track when the task was first
created. You can also type a “Status” and a “Due Date” in the Notes field to track this type of
information.

As you begin using Appointment Book events to manage your daily tasks, you may discover other
ways that Dentrix can help you manage your to-do list. I’ve discovered one thing—it’s a lot better than
using sticky notes!

LEARN MORE
To learn more, see the “Setting up views” and “Scheduling events for operatories” topics in the
Dentrix Help.
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WORKSHOP WISDOM

W

W

This excerpt from the Accounts
Receivable Management
workshop will teach you how to
make billing statements easier
for patients to understand and
how to copy billing statements
to the Document Center. Follow
along with the step-by-step
instructions and advice in this
article to empower your staff to
better manage billing statement calls and questions.

REDUCE THOSE
PESKY BILLING
S TAT E M E N T C A L L S

I

In an ideal world, patients would pay their full balance at the time
of service and insurance carriers would pay exactly what they are
expected to pay. The reality is that patients will often end up with
a balance on their account from unpaid patient portions or lowerthan-expected insurance payments. One of the easiest ways to notify
patients about their balance is by sending them a billing statement.
Most offices have experienced and even come to expect the flood of
calls that come after patients start receiving billing statements. These
calls can be frustrating and time consuming for your patients and
your staff members when patients don’t understand what they are
being billed for and staff members don’t have the billing statement in
front of them and can’t see what the patients are seeing.
Billing statements are a necessity, so why not do what you can to
provide enough information for your patients and staff members in
the first place rather than just planning on being frustrated? Do what
you can to make the statements easy for patients to understand,
and set up Dentrix to provide staff members with a copy of each
patient’s statement.

THE PROBLEM: Patients don’t understand the information
listed on their statements. They don’t know where the balance
is coming from because there isn’t enough detail on the
statement, so they call your office and ask you specific questions about
the line items—or lack thereof—they are seeing on the statement.
The problem is compounded when you don’t have a copy of the
patient’s statement and have to imagine what they are seeing, so it is
hard to answer their questions. You and your patients are frustrated by
the inefficiency in the communication, and you are spending too much
time on the phone answering billing statement questions.
T H E S O LU T I O N : There are two things you can do to solve
this problem: make the statement easier to understand and/
or provide staff members with a copy of each patient’s billing
statement.
1. Customize your billing statements —They are easier for patients
to understand in the first place. Are you providing patients
with enough information to understand what the bill is for and
when they received the treatment? When you create billing
statements, you can move the balance forward date on the
statement back a few months so that patients can see the
itemized list of procedures and payments and will have fewer
questions about where the balance is coming from. And you
can add a custom statement message for each patient to
communicate special information about their account.
2. Automatically add a copy of patients’ billing statements—set up
Dentrix to automatically add a copy of patients’ billing statements
to the Document Center. When a patient calls with a statement
question, you can open that patient’s Document Center and pull
up the same statement the patient is looking at. You’ll be able to
answer patient billing questions more easily and efficiently, which
will cut down on frustration and miscommunication.
18 | www.Dentrix.com/Magazine

FOLLOW
A

L

O

N

G

O P E N YO U R D E N T R I X SYS T E M A N D U S E T H E F O L LOW I N G S T E P S TO
C U S TO M I Z E B I L L I N G S TAT E M E N T S E T T I N G S TO M A K E T H E M E A S I E R
TO U N D E R S TA N D, TO S E N D A C O P Y O F B I L L I N G S TAT E M E N T S TO
T H E D O C U M E N T C E N T E R AU TO M AT I C A L LY W H E N E V E R YO U P R I N T
S TAT E M E N T S O R S E N D T H E M E L E C T R O N I C A L LY T H R O U G H E C L A I M S ,
A N D TO V I E W S TAT E M E N T S I N T H E D O C U M E N T C E N T E R .

STEP

1

G E N E R AT E S TAT E M E N T S T H AT A R E E A S I E R F O R
PAT I E N T S TO U N D E R S TA N D

It can be hard for patients to understand the information
listed on their billing statements, particularly when the balance
is over 30 days old or when there are multiple patients and
procedures listed on the statement. There are three Dentrix
features you can use to make billing statements clearer and
easier for patients to understand, which will cut down on the
number of billing statement calls you receive from patients.
The first thing you can do to make statements easier to
understand is to change the balance forward date on the
statement. The balance forward date determines which
procedures will be itemized on the statement. Procedures
or transactions that are newer than the balance forward
date will be itemized and listed on the statement, and
procedures or transactions that are older than the balance
forward date will be grouped together into one line item
labeled “balance forward.”
To change the balance forward date, from the Office Manager
click Reports > Billing and edit the date in the Balance
Forward Date field (Figure 1). By default, the balance forward
date defaults to one month ago, but you could move that
date back 60 or 90 days. That way, if patients have a balance
that is over one month old, patients will still be able to see
the itemized list of procedures and transactions and will
know what they are paying for.

Figure 1 Adjust the date in the Balance Forward
Date field to include more procedures and
transactions on the statement.

(Note that moving the date too far back in time may result
in the patient seeing a lot of old information, which will then
generate more questions. Experiment with this date to see
what works best for your practice.)

patients about their balances or made special arrangements
with them, you can also add a custom statement message for
individual guarantors.

You can also make statements easier to understand by
adding a custom message on statements. In the Billing
Statements dialog box you can add a statement message
that will print on the bottom of all the billing statements
for all patients. But in cases where you have spoken with

To add a custom statement message for a specific guarantor,
from the Ledger click the Guarantor Notes button. In the Billing
Statement Note section, type the note specifically for that
guarantor. The note will print on that guarantor’s statements
until the date you set in that dialog box.
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W
WORKSHOP WISDOM

STEP

2

W

E N A B L E T H E O P T I O N TO CO PY B I L L I N G STAT E M E N TS
TO T H E D O C U M E N T C E N T E R

Once you have made the statements easier
for patients to understand, you can set
Dentrix up to automatically add a copy of
the billing statements to the Document
Center so that you can look at the same
statement the patient is looking at when
they call with questions. You only need to
enable this setting once, and then every time
you print billing statements or send them
electronically with eClaims the statements
will be copied automatically.
To enable this option, from the Office
Manager, click Maintenance > Practice
Setup > Preferences, and then click the
Print Options tab. Check the Copy Billing
Statement to Document Center option, and
click OK (Figure 2).
Note: In order for a copy of the statement
to be saved in the Document Center, you
must either print the statement or send it
electronically. Simply generating a statement
and storing or previewing it in the Batch
Processor will not send a copy of the
statement to the Document Center.
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Figure 2 Enable this option to automatically copy billing
statements to the Document Center when statements are printed
or sent electronically.

STEP

3

V I E W T H E B I L L I N G S TAT E M E N T I N T H E PAT I E N T ’ S
DOCUMENT CENTER

When Dentrix automatically copies billing statements into
the Document Center, the statements are filed under the
appropriate guarantor in the Billing Statements category.
The statements are labeled within that category with the
date they were printed or sent electronically.
To view the billing statements in the Document Center,
select the patient whose billing statements you want to
view, expand the Billing Statements category by clicking
the + next to the category name, and select the statement
you want to view based on the statement date listed.
You want to be able to view the statements in the
Document Center large enough that you can read the
information printed on them. There are a few tricks
you can follow to enlarge the statement preview in the

Document Center and make them the size you need them
to be in order to communicate with your patients about
the statements.
With the document selected, click X to close the
thumbnail preview and click the < to close the thumbnail
toolbar and view the full document. This will give more
space on the screen for you to view the statement
(Figure 3).
To zoom in on the billing statement, press both the Ctrl key
and the + key on the keyboard. To zoom out, press both
the Ctrl key and the - key on the keyboard. You can also
see more of the statement by clicking the << button on
the thumbnails pane and minimizing the thumbnail view.

Figure 3 View statements in the Document Center so you can see what your patient is seeing.
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STEPS
U S E T H E F O L LOW I N G C H E C K L I S T TO
H E L P YO U I M P L E M E N T I D E A S F R O M
T H I S A R T I C L E I N YO U R P R AC T I C E

Decide how far back to set the balance forward date on
statements, and then train the staff members who create
billing statements to adjust that date every time they
generate billing statements.
Instead of handwriting notes or using stickers on statements,
enter digital notes that will print on statements. Enter notes
that apply to all patients in the Statement Message field in
the Billing Statements dialog box, and enter notes that apply
to a specific family in the Billing Statement Notes field in the
Guarantor Notes dialog box. Make entering billing statement
notes a part of your regular billing statement process.
Look at the other billing statement options available in the
Billing Statements dialog box. Make note of which options
you want to use consistently. Set up those options, then save
them as default.
Enable the option to copy billing statements to the
Document Center. Train your front desk staff to open the
Document Center and refer to the copy of the statement
when patients call with billing statement questions.
During your next team meeting, teach your team how to
work with the zoom settings in the Document Center and
view billing statements on the screen.
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Dentrix workshops offer you a
chance to practice using Dentrix
in a hands-on, trainer-led class.
Workshops offer examples of best
practices for using Dentrix in your
office, ideas for incorporating lesserused features into your workflow,
and advice about how to customize
Dentrix to suit your preferences.

LEARN MORE

For more tips like the ones in
this article and to get in-depth
training on managing patient
billing in Dentrix, attend the
Accounts Receivable
Management workshop. Visit
www.Dentrix.com/Workshops
for more information about this
and other training workshops,
including the full course list, course
descriptions, and schedule.

Put more of Dentrix
to work for you.
Ever wonder if you’re doing things the hard way?
Find out what tools you’re not using at a Dentrix workshop.

Coming to cities nationwide this spring.

Insurance: Billing
and Collections

Do it right to get paid faster

Accounts Receivable
Management
6 CE CREDITS

Take control of your patient A/R

6 CE CREDITS

Gain an in-depth understanding of how to correctly bill
insurance in order to increase claim acceptance and
collect more quickly and easily.

Learn to simplify the billing statement process, enhance the
effectiveness of collections efforts, and properly track and
manage important A/R routines.

$299 per
person

$299 per
person

1-day class for experienced Dentrix users
9 am – 5 pm | AGD subject code: 554

Treatment Planning
and Case Presentation

Create and present treatment options effectively

1-day class for experienced Dentrix users
9 am – 5 pm | AGD subject code: 550

Clinical
Charting
6 CE CREDITS

Move beyond just posting procedures

6 CE CREDITS

Learn in-depth how to create, customize, present and
manage patient treatment plans for improved patient
education, case acceptance and documentation.

Discover features that make charting easier and more
efficient. Learn to create thorough, accurate clinical
records in the Dentrix Patient Chart and Perio module.

$299 per
person

$299 per
person

1-day class for experienced Dentrix users
9 am – 5 pm | AGD subject code: 738

Essentials
Workshop

Master the basics

EARLY REGISTRATION SAVINGS!

12 CE CREDITS

Become familiar with the essential Dentrix features that
will help you work more effectively in your practice, and
make your daily routines easier and more efficient.

$449 per
person

1-day class for experienced Dentrix users
9 am – 5 pm | AGD subject code: 734

$40 OFF
per seat

when you register at
least 3 weeks early!

Earn 6 CE Credits per day

2-day class for newer Dentrix users
9 am – 5 pm | AGD subject code: 550

View course descriptions and register online at www.Dentrix.com/Workshops or call 866.367.2711
Mastery Tracks professional skills assessment included with these workshops.
©2016 Henry Schein Inc. A-DTXTRN-DTXMAG-Q416
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The Dentrix
Office Manager

Helping Patients Own Their
Insurance Benefits

Save time by teaching patients how to
manage their own insurance benefits.

D

ental insurance benefits can be a thorn in our side.
Checking benefits, eligibility, and maximums for
our patients is a nice service to provide, but it also
requires significant time—time that we could spend doing
other things to help manage the practice. There needs to
be a balance so that verifying insurance information is a
genuine customer service benefit and not a hand-holding
exercise. The insurance benefits belong to the patient, not
to the practice, and we need to hone the verbal skills to
help our patients understand this.
One thing I have been doing with my practices is
teaching them to transfer that ownership back to the
patient in a way that is beneficial to the patient and not too
time-consuming for the practice. The easiest, most efficient
way I have found is using the eCentral Insurance Eligibility
feature inside of your Dentrix software. Have you seen the
“E” icon on appointments in the Dentrix Appointment Book
or the Insurance block of the Family File (Figure 1) and
wondered what it does? All you have to do is click on the
little “E” and it searches for that patient’s insurance benefits
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Figure 1 The “E” Eligibility icon in the Family File Insurance
block.
and provides you with an instant, real-time benefits
breakdown and maximum used. Really. It is that simple.
The color of the Eligibility icon indicates the patient’s
eligibility status (Figure 2). A blue E on a white background
indicates that the patient is eligible for benefits. A gray
E on a yellow background can indicate that the patient’s
eligibility is questionable, has not been checked, was
entered manually in the past five days, isn’t supplied by the
insurance company through eCentral, or that the patient

from your plan. Notice I have highlighted some of the
important things about your plan. One thing I want to
point out is that if there is a procedure you need that is not
on this printed copy, then we don’t know how much your
insurance company will pay, so we estimate zero.”

doesn’t have insurance. In these instances,
the patient probably needs to follow up
with his or her insurance company.
Now I know some of you are saying,
“Sounds great, but I am not going to
spend the money on eCentral.” I respect
your desire to save a dollar, but I want
you to look at whether this is one of those
expenses that will actually make you money.
If you can cut down on the time your front
office is spending on the phone with insurance companies
by just one hour, your front office could be spending that
time calling patients with unscheduled treatment or pastdue hygiene appointments. Also, one hour a day in increased
productivity adds up to a lot more profits for the entire team.

Figure 2 The icon
color indicates the
patient’s eligibility
status.

Let me share with you some of my tips in using this
amazing tool.
Suggestions When Dealing With Patient Insurance Benefits
What has worked really well for many offices is to print a copy
of the electronic benefits for the patient and then send a copy
to the patient’s Document Center for your reference. Now,
how you hand off the information to the patient makes a big
impact on how much handholding you will need to do in the
future. So here are some of my best suggestions:
•

When you print the eligibility benefits from eCentral for
the patient, highlight a few key pieces of information (insurance company phone number, maximum and coverage
percentages).

•

Hand the patient the printed copy of his or her benefits
and say something like, “I took the liberty of checking on
your dental benefits for you and here is what we received

•

Let patients know that if they would like more details
about their plan, you highlighted the insurance company’s
phone number for them.

Using eCentral Insurance Eligibility will help you to strengthen
your relationships with your patients, and they will trust you
more. That trust will help build your practice and grow your
referrals.

LEARN MORE
To learn more about insurance eligibilities, see the “Insurance
Information” topic in the Dentrix Help.

Dayna Johnson, founder and principal consultant of Rae
Dental Management, helps dental offices improve patient care,
increase collections, and reduce staff headaches by implementing efficient management systems. With 20 years of
experience in the business and technical side of dental offices,
Dayna’s passion for efficient systems is grounded in both
personal understanding and professional expertise. Dayna can
be reached at dayna@raedentalmanagement.com or visit her
website at www.raedentalmanagement.com.

DAYNA JOHNSON
Certified Dentrix Trainer
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Business of
Dentistry

Get Your Staff Expenses Under Control

High staff expenses cut into profitability.
Review three ways to manage your
staff expenses.

an 8:00 a.m. patient and then “keep busy” until the next
patient at 11:00 a.m. Block your schedules, train your
administrative team to schedule in those blocks, and keep
an eye out for holes in the schedule.

A

If holes in the hygiene schedule are consistently a problem,
count up the open hours each day. Let’s say you have a
team of three hygienists and you’re counting six to eight
cumulative open hours in their schedules each day. It may
make sense to let one hygienist go so you can condense
your schedule and keep your other hygienists busy.
Although letting staff go isn’t any fun, it could be the one
big change that fixes your staff expense problem.

s I look at the income statements for several
practices, I’m seeing a trend. The profitable practices
all have one thing in common, and the struggling
practices are all missing this same thing. The common
denominator for profitable practices is that each and every
one has their staff expenses on target. And every practice
struggling to make a solid profit also struggles with staff
expenses.
Reduce Staff Expenses
First, take a look at your time clock reports. When does
your team clock in? If your first patient is at 8:00 a.m. and
you hold a quick 10-minute huddle before opening, but your
team is clocking in at 7:15 a.m., that’s an extra 15-20 minutes
per person each morning in staff expense. Next, is your
team clocking out for their full lunch hour every day? And
most offices have one person that’s “willing” to stay late—
and that person will be clocked in for an extra hour at the
end of the day.
Sit down with your team and set clear guidelines for
clocking in/out. They can clock in 15 minutes before huddle,
clock out for their full lunch hour and clock out 15 minutes
after their last patient. Your job is to periodically check the
time clock reports to make sure staff members are following
these guidelines.
Next, look at your schedule. Are you leaving big holes in
the 10:00 a.m. to 2:00 p.m. hygiene columns? If so, the
clinical staff can come in later or leave earlier. It kills your
staff expense percentage to have hygienists clock in for
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Improve Production
Let’s look at a few ways to improve production. Perhaps you
should reduce the duration of hygiene visits. Take your onehour recall visits down to 45 minutes, or move your child
prophies from 45 minutes to 30. By increasing the volume
of appointments you can schedule in a day you can impact
your staff expense without cutting team members.
Next, take a look at your broken appointments. If heavy
no-shows are causing open time in your schedule, then it’s
time to re-evaluate your approach. Update your policies and
charge chronic no-show patients a fee to pre-book.

By increasing your collections—
not just a one-time bump, but a
maintained increase—you can
offset your staff expense and
improve your profits.

Figure 1 The Insurance Aging report can show all the communication you’ve had with an insurance company.

Next, improve your approach to filling the schedule. Make sure
your staff members are making full use of the Unscheduled List
(from the Appointment Book, Appt Lists > Unscheduled List)
and the Continuing Care module (launched from the Continuing
Care button in the Appointment Book). The Unscheduled List
and the Continuing Care module are fluid lists that update as
you make changes in Dentrix. Assign team members to call
using these lists and hold weekly or monthly meetings to assess
the current backlog of unscheduled appointments and missed
recall opportunities. By filling schedules and holding your team
accountable, you can improve the staff expense percentage.
Increase Collections
Let’s say your production is strong, but the real problem is
collections. Your staff expense ratio could be out of balance
simply because your manager isn’t spending the time necessary
to call insurance carriers on the Insurance Aging report. In
Dentrix, you can easily run your Insurance Aging report (from
the Office Manager, Reports > Ledger > Insurance Aging
Report) and review notes of your collection efforts (Figure 1).

The common denominator
for profitable practices is that
each and every one has their
staff expenses on target.
Beyond insurance, meet with your manager to review the
collections process. Are you sending statements monthly?
What collections efforts is she making? What happens when
a patient doesn’t pay? Dentrix allows you to run the Aging
Report (from the Office Manager, Reports > Ledger > Aging
Report) sorted from largest to smallest balance so you can
tackle worst first (Figure 2). By increasing your collections—
not just a one-time bump, but a maintained increase—you can
offset your staff expense and improve your profits.
Conclusion
Right about now, you may be realizing there are dozens of
aspects of your practice that you could be working on to
improve your staff expense. And, you’re right. The key is to make
changes. Don’t just accept that your staff expenses are too high
and there’s nothing you can do. Decide that you’re going to run
a profitable practice and then continue to make changes until
you achieve the staff expense balance you need.

Jill Nesbitt, MBA, is a group practice dental consultant offering
free practice management resources and an online dental staff
training program at www.dentalpracticecoaching.com

Figure 2 Sorting by dollar amount allows you to tackle “worst first.”

JILL NESBITT
Dental Consultant
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TechNotes

Add Wi-Fi to Your Waiting Room
the Smart Way
Give your patients a perk they appreciate
without risking your practice or patient data.

Y

ou may be considering or already offering Wi-Fi as a
courtesy for your patients. It’s a great idea, and many
practices are adding Wi-Fi access in their waiting rooms.

Wi-Fi hotspots are, well, hot. According to Cisco’s Visual
Networking Index (VNI) IP traffic forecast, 63 percent of all
Internet traffic will travel over Wi-Fi by 2019.1 The number of
public hotspots is exploding, expected by iPass to grow to
almost 300 million in 2018.2
Just a few years ago, practice visitors were surprised if a
Wi-Fi hotspot was available; but as technology becomes
more a part of their everyday lives, patients now are
frustrated when they can’t stay connected wherever they
are. So give them what they want.
Why Wi-Fi?
Your practice likely has Internet connectivity—maybe
even Wi-Fi—so why not add a guest network? Consider
these benefits:
•
•
•
•

Show patients you value their time by helping them
stay productive while they wait.
Reduce magazine subscriptions and clutter in your
waiting room.
Create goodwill for prospective customers, especially
friends or relatives waiting for patients.
Gain a competitive advantage over other practices.

Security is Key
While there are many benefits to providing a Wi-Fi hotspot,
the downside is that network security attacks are on the
rise. It’s important that dental organizations develop a
wireless strategy to help minimize the risk of hackers
stealing their patients’ valuable data.
A hacker can use what is known as a man-in-the-middle
attack to intercept keystrokes and capture passwords when
people use Wi-Fi. The hacker simply sets up an access
point that mimics a legitimate network connection name
and tricks a device into joining their network. The Internet
is basically routed through the attacker, who can silently
intercept personal data without the user being aware.
Dental practices and other small businesses are hot targets
because they may try to get by with inadequate cyber
security protection. Last year nearly 50 percent of small

businesses were impacted by cyberattacks, with an average
cost to the business of more than $20,0003 in loss of service
and/or stolen credit card or bank account information.
Be Smart
Installing Wi-Fi in your practice comes with a responsibility
to your patients. It’s critical to properly configure your
router to help safeguard your practice and patients, and
to increase the likelihood that you’ll keep inappropriate
websites and malware out. When deploying, upgrading, or
managing Wi-Fi access for visitors to your practice, follow
these guidelines:
1. Be sure that your hotspot has integrated Wi-Fi security
capabilities and services. Services to look for include:
•
•
•
•

Anti-virus protection
Anti-malware
Intrusion prevention
Application control and web content filtering

2. Segment your networks to increase the likelihood that
you’ll keep the public out of your business data. Your
guest Wi-Fi network needs to be just that—a separate
network just for your customers.
3. Include a disclaimer, and require a password to log on
to your network. If your reception staff provides the
password to patients, you can reduce the risk of the
wrong people using your network.
4. Consult with TechCentral for IT recommendations and
solutions that can help keep your practice data and
computer systems protected.
Providing Wi-Fi access can be a great way to help your
practice attract customers and build goodwill with patients,
but a practice can lose thousands of dollars and valuable
staff productivity when technology fails or common Internet
threats compromise computer systems and data. By thinking
ahead and making protection a priority, you can give your
patients a perk they appreciate while minimizing cyber risks
for yourself and your patient data.
Henry Schein TechCentral offers superior office technology
solutions that are optimized and integrated for dental
practices. With a single-source team of professionals that
design, deliver and support networks and security solutions,
you can trust the tech professionals at TechCentral. To learn
more, visit www.HSTechCentral.com/ProtectYourPractice.
RYAN ORSI
Director of Strategic Alliances
WatchGuard Technologies

1 http://investor.cisco.com/investor-relations/news-and-events/news/news-details/2015/Cisco-Visual-Networking-Index-Predicts-IP-Traffic-to-Triple-From-2014-to-2019Key-Growth-Drivers-Include-Increasing-Mobile-Access-Demand-for-Video-Services/default.aspx
2 https://www.ipass.com/press-releases/the-global-public-wi-fi-network-grows-to-50-million-worldwide-wi-fi-hotspots/
3 http://www.foxbusiness.com/features/2015/04/07/is-your-small-business-at-risk-for-cyber-attack.html
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YOU PROTECT
YOUR PATIENTS’
TEETH, BUT WHAT
ABOUT THEIR
IDENTITY?

Don’t be fooled into a false sense of security. A single
data breach could steal the practice you’ve worked
so hard to build, due to patient loss, high fines and
legal fees. TechCentral Protected Practice solutions
help you prevent disaster before it occurs.
TechCentral: Protect your practice

Download the FREE eBook "Avoiding Malware in
Your Dental Practice: 10 Best Practices to Defend Your Data"
Get it now: www.HSTechCentral.com/DefendYourData

SOLUTION SPOTLIGHT
Updox andand
Dentrix:
ImageRamp
Dentrix:

Care
Coordination
Solutions
to Center
Maximize
Easily
Scan
to the Dentrix
Document
Revenue and Performance
AISLING BABBITT
Director of Marketing

Learn how Updox can help your practice
lower costs, increase revenue, enhance
workflow, maximize staff time, and
increase efficiencies.

B

usy dental practices don’t have time to be slowed
down by paper-based processes, disconnected
communication channels, or an inability to engage
patients. What if there was a platform that lowered your
overhead costs, supported secure message exchange with
providers and patients, and was as simple to use as email?
Meet Updox! We’re a certified Dentrix Connected solution
that provides a cohesive care coordination suite fully
integrated with Dentrix G6. Updox for Dentrix lets you shift
your focus more to patients and less to management of
multiple applications from various technology partners. If
your practice is looking to lower costs, increase revenue,
enhance workflow, maximize staff time, and increase
efficiencies, your practice is ready to Updox!
Updox for Dentrix offers several benefits to help drive
practice efficiency.

Figure 1 With Updox, your faxes arrive as PDFs. You can scroll over the
thumbnail and a preview pops up.
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Engage Patients
Updox for Dentrix offers an enhanced patient experience with
an easily implemented and cost-effective patient portal for
complete patient engagement. The Updox patient portal is
intuitive and simple to use, offering several features to reduce
the costs of getting information to your patients, increasing
patient engagement, securely exchanging messages about
care, and providing ways to increase practice revenue.
From scheduling requests to online payments to follow-up
questions after procedures, the patient portal makes it simple
and fast for your patients to communicate with your practice.
Digitize Workflows
The average dental practice spends about $162 every month
on faxing. For every 5,000 fax pages, these costs include
about $72 on toner, $50 on paper, and $40 for each monthly
fax line. On top of that, there is the staff cost. Consider that
office staff spend about two minutes per fax—going to and
from the fax machine, manually dialing numbers, printing and
filing transmission reports, scanning faxes into charts, and
locating or duplicating work to find faxes or fax them again.
Now, think about the number of faxes your practice sends
and receives every day. Multiply each of those two-minute
segments by the rate you pay your office staff and add up all
the costs—that’s how much faxing is costing your practice.
There is a better way!
Updox offers an electronic web-based paperless process
that puts that money back into your wallet. Your fax arrives
as a PDF (Figure 1). Depending on where it came from, it can
be queued to arrive at one specified inbox (Figure 2). For
example, lab reports go to one inbox, referrals to another, and
so forth. That PDF can be divided up page by page so that
only the necessary pages are routed, filed, or refaxed. Online
editing tools let you edit faxes to add information, make notes,
highlight key information, date items, redact data or personal
information, or insert a signature. Everything is electronic;
nothing needs to be printed or scanned. Then, that edited fax
can be routed for review, faxed back, and filed in the Dentrix
patient chart—all at the same time (Figure 3). And with

Figure 2 Updox features a universal inbox that pulls together faxes, Direct emails, and portal messages into one central location.
Updox, if that return fax number is busy, there’s nothing else
to do. We’ll continue to resend until it goes through, and you
can easily check the status to see when it was delivered. With
Updox, there’s no printing, copying, scanning, walking faxes
around for signature, or adding to stacks of paper waiting to
be filed in charts. Updox for Dentrix lets you focus more on
patients and less on paperwork.
Communicate Securely
Updox is also the leader in Direct secure email, a web-based,
HIPAA-compliant communications channel used to connect
healthcare providers. Direct has become the preferred
channel to communicate private health information between
care team members, including transitions of care, lab/test
results, patient communication, and referral information.
With Updox for Dentrix, dentists can use secure Direct
email to easily connect with physicians, expand referral
networks, and join care integration teams. The Updox Direct
Network includes the vetted addresses of nearly one million
healthcare providers (Figure 4).
Updox to Go
Another way Updox saves time and improves efficiency
is by being fully mobile. When you are out of office, at
another office, on the road, or taking a well-deserved
vacation, it’s easy to log in to your universal Updox inbox.
All your faxes, portal messages, and Direct emails are in one
spot, making it simple and convenient for you to quickly
review and respond from your phone or mobile device.
Updox is a Trusted Dentrix Partner
Because of the new Dentrix Connected certification, Updox
solutions are available in an easy, integrated component to
Dentrix G6 customers. Updox is a no-risk option. We’re a
month-to-month service with no long-term contracts. We’ll
get you up and Updoxing quickly with free setup, training,
and phone and email support. Plus, you can start today with
a free 15-day trial. More patient time, less paperwork—that’s
the Updox promise. If you’re ready to maximize your practice
performance, you’re ready for Updox—Where Healthcare
Connects. Learn more and start your free trial today at
www.updox.com/updox-dentrix.

Figure 3 With Updox, it’s just a few mouse clicks to send information to
the Dentrix patient record or message the patient via the patient portal.

Figure 4 It’s easy to add a new contact or patient contact to your Updox
address book.

The businesses featured in this column are not owned or controlled by Dentrix or
Henry Schein and have provided the description of their company, products, and
services themselves. Dentrix and Henry Schein make no independent assessment
of the above information, and consumers should contact these providers directly if
seeking additional information about their products or services.
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SOLUTION GUIDE
You already depend on Dentrix to make your practice more profitable and productive. Now, you can turn
Dentrix into an even more powerful solution by adding trusted, fully integrated third-party applications
and capabilities to your digital dental office. The Dentrix Connected logo means the product has been
carefully developed, tested and certified to work with your Dentrix platform. To see the full list of Dentrix
Connected applications visit www.Dentrix.com/Connected today.

Apteryx

Broadview

BiteBank Media

www.apteryx.com

www.broadviewnet.com

www.bitebankmedia.com

Dental Practice Solution

Network-based Business
Communication

Apteryx exceeds the expectations of its
customers by creating timely, innovative
and cost effective software solutions
that improve the profitability of the
clients’ businesses.

Dental Practice Solutions

Make your practice more profitable with
OfficeSuite Dental, the state-of-the-art
phone system that fully integrates with
Dentrix G5.

Streamline your practice with custom
dental websites, appointment
notification and scheduling, real-time
booking, patient education videos and
reputation management.

DocuFi

Demandforce

Dental Symphony

www.docufi.com

www.demandforce.com

www.dentalsymphony.com

Document Management Solutions

Patient Communication Solution

Dental Practice Solution

DocuFi™ is a certified Dentrix partner
providing tools to capture and process
documents into electronic digital form.
ImageRamp™ for Dentrix, using Fujitsu
scanners, offers the most productive
document scanning solution for Dentrix.

Demandforce works seamlessly with
Dentrix G5 software to automate
online and offline communications with
existing patients to improve in-office
efficiencies.

Dental Symphony’s web-based
clinical software revolutionizes patient
management. Working alongside
Dentrix, Dental Symphony provides
innovative tools to practice easier,
safer and more efficiently.
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DentalWriter

DEXIS

eDossea

www.dentalwriter.com

www.dexis.com

www.edossea.com

Medical Billing Software

Digital Diagnostic Imaging

Intra-Office Communication

For over 25 years, Nierman Practice
Management has led medical billing in
dentistry by continuously developing
innovative products and providing
exceptional training for dentists looking
to grow their practice.

DEXIS delivers innovative, high-quality
digital imaging solutions to the dental
community. With its state-of-the art
sensor and easy-to-use imaging
software, Dexis provides numerous
benefits to you, your practice, and your
patients.

We are solely focused on the dental
profession and within the dental
profession on the secure, easy and
inexpensive transfer of your client’s
medical records from one office to
another. This is all we do.

Jakari Care

Lighthouse

Panda Perio

www.jakaricare.com

www.lh360.com

www.pandaperio.com

Patient Health Information

Patient Communication Solution

Periodontal Practice Solution

Less work. Better care. Let our HIPAAcompliant solution automatically collect,
analyze and transfer patient medical
history, treatment goals and other
important information into Dentrix.

Lighthouse 360 is a comprehensive
automated patient communications
system designed exclusively for dentists.
It uses email, two-way text messaging,
automated phone calls, postcards and
letters to reach your patients.

The complete clinical digital record
for Periodontal practices. Charting,
comparison reporting, treatment
planning, automated chart notes, and
much more. Save hours of admin time
and unify your front and back office.

Patient Activator

Practice Mojo

Practice Safeguard

www.patientactivator.com

www.practicemojo.com

www.practicesafeguard.com

Patient Communication Solution

Patient Communication Solution

Web-Based Fraud Monitoring

Patient Activator, part of Los Angelesbased 1-800-DENTIST®, is the leading
social media optimization and patient
communications service dedicated to
the dental profession.

PracticeMojo creates proven campaigns
that help dental practices recruit, retain
and reactivate patients automatically,
using email, text messages, automated
phone calls and mailed postcards.

A web-based financial monitoring tool for
Dentrix G5 users that deters fraud and
costly errors by alerting any device you
carry to unusual transactions in real time.
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RecordLinc

Reputation

Sesame

www.recordlinc.com

www.reputation.com

www.sesamecommunications.com

Patient Communication Solution

Patient Communication Solution

Patient Communication Solution

RecordLinc is the largest professional
network of dental professionals in
the world. Securely and easily send
electronic referrals, patient transfers, and
track treatment plans between dental
practices in a HIPAA-compliant portal.

Reputation.com’s platform enables
dentists to see all their online reviews
in one space and use the platform’s
analytical tools to understand the
broad themes that emerge from
patient feedback.

Sesame Communications helps dental
and orthodontic practices harness the
power of the Internet to accelerate new
patient acquisition, build patient loyalty
and transform the patient experience.

Solutionreach
www.solutionreach.com

TeleVox
www.televox.com

Text2Floss
www.text2floss.com

Patient Communication Solution

Patient Communication Solution

Patient Education

Smile Reminder provides patient
engagement and communication
solutions for healthcare practices.
Utilizing the latest text, email, voice,
video, web, and social media tools to
communicate with customers.

TeleVox Software is a high-tech
engagement communications company,
providing automated voice, email, text
and web solutions that activate positive
patient behaviors through the delivery
of a human touch.

An interactive educational tool meant
to help patients develop positive oral
hygiene habits by delivering oral health
information through the use of text
messaging and mobile technology.

Transparent Aluminum
www.transparentaluminumllc.com

U.S. Health Record
www.teamlinks.com

Yapi
www.yapicentral.com

YAPI
Dental Practice Solution

Intra-Office Communication

Dental Practice Solution

Transparent Aluminum is a company
focused on creating custom workable
solutions for practices to get the most
out of their Dentrix database.

Teamlinks EHR was created to foster
interdisciplinary collaboration on
patient health information with the goal
of connecting the health care team and
the patient.

Started as the first fully integrated
intra-office communication software,
YAPI has grown into a comprehensive
suite of innovative automation solutions
designed around unique needs of
dental practices.

The businesses listed here are not owned or controlled by Dentrix or Henry Schein and have created these descriptions of their company, products
and services themselves. Dentrix and Henry Schein make no independent assessment of the above descriptions and consumers should contact
these providers directly if seeking additional information about their products or services.
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DATA CAN TELL YOU
WHAT’S RIGHT AND
WRONG IN YOUR
PRACTICE

IMPROVE YOUR PROFITABILITY

Meet with a Dentrix Profitability Coach for a free 30-minute assessment.
See what your data says about your practice’s strengths and weaknesses,
and key areas to improve to immediately boost profits. Act now.
SCHEDULE YOUR FREE PRACTICE ASSESSMENT NOW AT

DENTRIX.COM/DENTRIXMAGCOACH
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Henry Schein Practice Solutions
1220 South 630 East, Suite 100
American Fork, Utah 84003

TAKE YOUR
PRACTICE TO
A NEW LEVEL.
Dentrix Suites are support and eServices bundled
together for a suite deal. As a Dentrix user with a
customer service plan, you’re already on your way
with the Dentrix Essentials Suite. Now it’s time to
take your practice to the next level by upgrading
to Momentum or Optimum. Dentrix Suites lower
your costs and give you the practice management
system you need to streamline workflow, build
patient loyalty and boost your bottom line.

Dentrix.com/Suites

YOU
ARE
HERE.
Dentrix Momentum Suite

Dentrix Essentials Suite

Dentrix Optimum Suite

